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1  WHAT’S THIS GUIDE ABOUT?

This guide gives you a very quick introduction to Mari. It doesn't go into 
great detail, and assumes you're already familiar with CG painting software. 
Read this if you have twenty minutes to figure out what it's all about before 
you start painting assets.

If you have more time and want to learn how to use Mari more effectively, 
check out the Mari Getting Started Guide and Mari User Guide. Get these 
from the Help menu.



2  THE MARI WORKSPACE

Here is an illustration of the Mari workspace that displays when you first 
open the program.

Workspace

Menubar To select Mari commands (many of which are also available using 
shortcut keys and/or icons).

Toolbars To click icons for common Mari functions or settings.

Canvas Where you view and paint your geometry.

Tabs To switch between views.

Palettes Controls for viewing and changing different aspects of what's on the 
canvas.

Statusbar Information about the project generally, progress of long operations 
(such as baking), and icons.

Menubar

Toolbars

Canvas

Tabs

Palettes

Statusbar



3  MANAGING PROJECTS

A Mari project stores your work on geometries and associated textures. 
Mari's Project tab holds all the projects you are working on.

Creating a new 
project

1. Do one of the following:

The New Project dialog box displays.

2. Set the project's Name (for you to identify it only — this is not a 
filename).

3. Select the geometry file for the project in the Path field. The drop-down 

lists the last 10 files selected, or you can click  to browse to a file.

Select from 
menubar

or click on 
toolbar

or click on the 
Project tab

or type 
shortcut key

File > New New Ctrl+N



MANAGING PROJECTS 7
Creating a new project 
4. If you are loading an animated sequence, the Mesh Options tab displays.

Specify the range of animation frames to import.

5. On the Texture tab, click to select which of the channels in the list to 
create. You can select a different Category from the list – the set of 
channels updates with channels for your selected category.

Click boxes under Create and Import to set the options. You can right-
click to get a pop-up menu allowing you to easily create or import all the 
channels.

Tip Click Scan to make Mari scan the project's root path for any existing 
textures. If any textures exist for your channels, Mari shows a green dot 
next to the channel. You can select to import these textures.

As with the project name, the channel Name is for you to identify it only — 
when you export you can select a different name.

For the Type, choose Color for anything color-dependent (and Mari will 
apply the viewer LUT automatically), or Scalar for a mask or displacement.

If you select a different Depth or resolution, file sizes can vary dramatically 
(for example, a 2K RGB “Byte” texture file is 2MB — whereas a 4K “Float” is 
172MB).

6. Click OK.

Mari checks the model for any errors that might prevent it from pro-
cessing, for example whether UVs overlap or touch border edges. A 
“Mesh Sanity Check” dialog displays any warnings or errors. (Errors can-
cel opening the model, but you can continue with warnings.)

7. Click to Continue. 
Mari 1.4v2The Foundry



MANAGING PROJECTS 8
Opening existing projects 
Mari renders your selection and displays it on the canvas.

Tip Depending on the size and complexity of textures, it can take several 
minutes the first time you load them into a Mari project. Once saved, 
however, the project should open quickly in future.

Opening existing 
projects

1. Click on the Projects tab. 

This shows all the projects you have on your computer.

2. Double-click on the project to open.

Saving your project Do one of the following:

Tip • Save your project often! 

• Note that while your textures remain cached locally, saving does not 
export them, so export often too!

• If you don't need to save (no changes since the last save), the toolbar 
icon is gray.

Select from menubar or click on toolbar or type shortcut key

File > Save Ctrl+S
Mari 1.4v2The Foundry



4  CHANNELS

Channels hold “layers” of paint in your project. For example, a project might 
have channels for diffuse color, displacement, specularity, or mask details.

Adding a channel to 
a project

1. Do one of the following:

The Add Channel dialog box displays, allowing you to set the options for 
the new channel.

2. Select a name, color channels, depth, type and base color for the 
channel (as with a new project), and click Ok.

The new channel displays in the Channels palette.

Tip If there are multiple objects in your project, there is no Ok button in the Add 
Channel dialog. Instead, you need to choose whether you want to import 
the channel onto the current object only or All Objects.

Adding a set of 
channels

1. Do one of the following:

The Add Multiple Channels dialog box displays. 

2. Select the type of object you're creating from the Category list.

The list of channels at the bottom of the dialog box expands to show all 
the channels for that kind of model. Select the channels to create.

3. If you have existing textures to import into the new channels, set the 
Root Path and make sure that the Files for each channel show the 
correct texture files.

4. Click OK to create and import the new channels. 

Select from menubar or click
or right-click on the Channels 
palette and select

Channels > Add Channel Add Channel

Select from menubar or click
or right-click on the Channels 
palette and select

Channels > Channel 
Presets

Channel Presets



CHANNELS 10
Adding a set of channels 
Tip To toggle quickly between the last two selected channels (while in the 
painting canvas), press T. 

For other options, such as duplicating, locking or resizing a channel, right-
click in the Channels palette.

When you Import channels, if there is a corresponding texture for each 
patch in the model, an indicator (red, green, or number) tells you whether 
your selection includes a complete set of textures.
Mari 1.4v2The Foundry



5  CONFIGURING YOUR WORKSPACE

The Mari workspace is completely configurable. As detailed on the pages 
that follow, you can customize how palettes display, your own personalized 
sets of brushes and colors, and shortcut keys.

Palettes Mari uses a number of palettes — windows that you can move around your 
workspace, with specific information and tools for working on your project. 
For example, the Channels palette shows all the channels in the project, and 
has controls for editing the channels.

To open palettes:

To move, size and arrange palettes:

Select from menubar or right-click on the menubar or toolbar and select

View > Palettes > <palette 
name>

<palette name>

To... Do this...

Undock and move a 
palette

Grab and drag it by its title bar to anywhere on your screen. 

(Or click  to undock, and then drag by its title bar).

Dock a palette to the window Move it to one of the edges of the Mari window. A dotted 
line displays along the edge where it can dock.

Dock a palette to another 
palette

Move it over another undocked palette. A dotted line dis-
plays where it can dock.

Size a docked palette Grab and drag the dotted bar along the bottom or side.

Size a floating palette Drag an edge or corner.

Stack palettes Drag and drop them directly on top of one another. 
Tabs appear for selecting which of the stacked palettes to 
display.



CONFIGURING YOUR WORKSPACE 12
Shelves 
Shelves The Shelf palette lets you store customized “shelves” of brushes, colors, and 
images. You can also share them with others.

Mari has the following kinds of shelves:

• The Menu shelf stores seven items available from the F9 onscreen pop-
up menu. These items must be numbered from 1-7 to appear.

• The Personal shelf stores items you select and configure for all projects.

• The Basic Brushes shelf stores a set of predefined basic brushes.

• The Hard Surface Brushes shelf stores a set of predefined hard surface 
brushes.

• The Organic Brushes shelf stores a set of predefined organic brushes.

• Customized shelves you create store items you select and configure for 
all projects.

Customizing shelves To add an item (brush, color, or image) to a shelf, drag it onto the shelf.
Mari 1.4v2The Foundry



6  CHANGING THE VIEW

As described below, Mari includes features for 3D navigation to view your 
model from various angles and perspectives, change the lighting on the 
mesh, and change the resolution of textures.

3D navigation You can move the view by holding down Alt.

Tip By default, Mari uses momentum when you are moving the view. When you 
let go of the mouse button, the model slowly coasts to a stop. You can turn 
this behavior off so that the model only moves when you are holding the 
mouse button down. To do so, right-click on the canvas, select Display 
Properties and uncheck Momentum Enabled under Navigation.

You can also use the keys 1-6 to switch between preset views (left, right, 
top, bottom, front, and back).

Press Home to cycle between hiding all palettes, hiding docked palettes and 
showing hidden palettes.

Use the tabs at the top of the canvas to switch between:

• Uv - a grid view showing the UV patches, 

• Ortho/Uv - a split screen showing the UV patches and the orthographic 
view, 

• Perspective - a perspective camera view, or

• Ortho - an orthographic camera view.

Tip You can also use the , , and  toolbar buttons or the F10, 

F11, and F12 keyboard shortcuts to activate a particular view on any tab.

To... hold down Alt and

Zoom in and out Ctrl-click and drag OR Right-click and drag

Pan left and right Shift-click and drag OR Middle-click and drag

Rotate the model Left-click and drag
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Lighting 
Lighting You can change the lighting on the main mesh by clicking on the toolbar:

Mari has four custom lights, which appear on the drawing canvas .

You can set the light details in the Lights palette. Mari uses these in the 
Basic and Full lighting modes:

• To turn a light on or off, click on the  icon in the list, or use the 

General > On checkbox.

• To change a light, click on it in the Lights list, and then set the color and 
strength.

• Select whether the light is fixed to the Scene or Camera.

• To move a light around, select the Pan Object tool , then click and 

drag the light around on the canvas.

Flat Basic Full
Mari 1.4v2The Foundry



7  PAINTING

Painting in Mari is similar to other standard paint programs. Paint using the 
various tools, then bake it onto your model. Most tools work on unbaked 
paint, but one or two work directly on the baked paint on the surface.

Tip Each tool has a set of keys that control how it works. By default, the option 
keys for the current tool are shown on screen at the top of the canvas.

To select a tool: 
Choose from your shelves or the Tools toolbar:

Painting a constant 
color

1. Click 

2. Click and drag to paint on the model.

Tip You can paint a straight line by:

• clicking one end point, moving the cursor, pressing Shift and clicking the 
second endpoint

• pressing Shift and holding down the mouse button while moving 
horizontally or vertically.

Paint tools

Select Marquee select Transform paint buffer
Zoom paint buffer

Pan object Blur Warp Slerp

Pinup Paint Erase Paint through

Paint gradient Clonestamp Towbrush Color picker/ Pixel 
analyzer



PAINTING 16
Customizing you brush 
Customizing you 
brush

1. Open the Brush Editor palette. 

The Brush Editor displays.

Tip • Resize the brush editor palette to minimize scrolling.

• There are many options for customizing your brush, including setting 
values for Paint, Pressure, Radius, Rotation, Bitmaps to use, Geometry 
and Noise.

• You can test the brush in the scratch pad at the bottom of the palette.

2. You can select a brush to modify from those available in your Shelves.

3. When you have finished creating a brush, click  to add it to 

the selected shelf.

“Painting through” 
an image

1. Open the Image Manager palette.

2. To load an image, click , navigate to and select the image file, and 

click Open.

A thumbnail of the image displays, along with information about the 
selected image.

3. In the Tools palette, click  (the Paint Through tool). 

4. Drag and drop the image from the Image Manager to the canvas. 
Mari 1.4v2The Foundry



PAINTING 17
“Painting through” an image 
5. Adjust the image size and position:

6. Paint!

Tip • You can quickly switch between the Paint and Paint Through tools by 
pressing P and U. 

• To hide the image, hold the ? Key.

• To paint the whole image onto the model in one step, press the ' 
(apostrophe) key.

• To toggle repeating the image, so you can paint past the edge of the 
floating image and have the paint continue, press the ; (semicolon) key.

To... Do this...

Resize Grab and drag its edges or corners, or press Ctrl+Shift then click 
and drag.

Move Grab the “handle” in the center of the image (or press Shift and 
click anywhere on the image), and drag.

Rotate Click and drag outside the image, or press Ctrl and drag inside the 
image. 

Press Shift when dragging outside the image to rotate in incre-
ments.

Crop Double-click the image in the Image Manager, drag the area you 

want to crop, and click .

Change the opacity In the Tool Properties palette, select Texture > Preview, and 
change the Preview Alpha (enter a number or drag the slider). Pre-
multiply alpha if your image has transparency.

Reset the image In the Tool Properties palette, select Texture > Transform > Reset.
Mari 1.4v2The Foundry



PAINTING 18
Clone stamping 
Clone stamping
1. Click .

2. Use the Source menu on the toolbar to select where to take the clone 
source from.

3. Hold down the Ctrl key and click to select the clone source point.

Tip When cloning from a channel, you can clone directly from the surface. In this 
mode, the tool clones the paint from the channel surface straight up into 
the paint buffer directly above that point. This lets you copy the model's 
surface into the paint buffer so you can edit it and then re-bake.

To use this mode, hold down Ctrl+Meta (or Windows key) when you click to 
set the origin point.

4. Paint to stamp your selection onto the model.

Moving and warping 
paint

To move paint on the model before baking:

1. Click .

2. Left-click anywhere on the paint buffer and drag to move the painting 
around on the model.

3. Ctrl+left click and drag to rotate the painting, or left-click and drag 
outside the paint buffer.

4. Ctrl+Shift+left-click and drag to resize the painting, or grab the corners 
of the paint buffer and drag.

Tip The paint buffer is visible on screen as a white box, but it may be larger 
than the view window and not visible. It will become obvious if you move or 
resize the painting. To reset the paint buffer to its default values click the 
Reset button in the Painting palette under Paint Buffer > Transform.
Mari 1.4v2The Foundry



PAINTING 19
Baking paint onto the model 
To warp paint before baking:

Baking paint onto 
the model

1. Make sure all patches you want to bake are selected.

2. Do one of the following:

Tip Whenever you change your view of the model, it bakes automatically. You 
can change this setting in the Projection palette if required.

Blurring baked 
paint

1. Click . 

2. Left-click and drag to blur paint baked on the surface.

Tip • As with the paint tools, you can edit the blur brush tip. 

• When you have finished blurring the paint, you need to bake.

Using this tool... You can...

 Warp
Shift-click and drag to create a warp grid. Click and drag the 
points around to warp the paint. To increase or decrease the 
grid resolution, press the up or down arrow keys.

 Slerp
Use the Slerp Mode menu on the toolbar to set the mode 
(from Pull, Grow, Shrink, or Rotate). Click and drag to apply 
your effect. Erase distortion by selecting the Erase mode.

 Pinup
Shift-click to set “pins”. Then click and drag to move the pins. 
You can use pins to protect parts of the paint that you don't 
want affected by the distortion.

Type shortcut key or click on statusbar

B

Mari 1.4v2The Foundry



8  SHADERS

Shaders control how Mari displays the model on the canvas. Mari's default 
shader shows the color from the current channel. You can build your own 
custom shaders by combining shader modules. Each module controls a 
single display effect. The modules you can use include:

• Combining two diffuse channels

• Showing a channel as a displacement map

• Using a channel as a luminosity map

• Combining channels using a third channel as a mask.

So you can build a shader that takes the details from multiple channels
in your project to render the canvas on screen.

Tip Shaders do not affect the contents of the channels, only how Mari displays 
the model on the canvas. For example, if you have a shader that combines 
two diffuse channels, the model on screen is displayed with a mixture of 
both channels. However, the channels are still separate and contain 
different data.

To create a custom shader:

1. In the Shaders palette, right-click and select Add SurfaceShader or 

click .

The new shader appears in the list, with details at the bottom of the 
palette.

2. New shaders start as a copy of the default shader. You can:

• Edit the existing modules.

• Click the Add New Shader Module button to add modules to your 
shader.
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The Add New Shader Module dialog appears.

Enter a name and select the Module to add. For example, to create a 
shader that shows one channel as a displacement map, select the Bump 
module.

3. Set the details of the shader modules.

Each module has different details. Adjust the values until you get some-
thing you like.

You can add as many modules as you need to build up your shader.

Tip If you build a shader that takes data from multiple channels, it can be hard 
to remember which channel you're currently editing. In this case, you can 
switch back to the default shader, which just shows the contents of the 
current channel.

For full details of the shader modules available, see the Mari User Guide.
Mari 1.4v2The Foundry



9  EXPORTING AND IMPORTING

Exporting To export a channel:

1. Manually select patches to export (if you don't select any, Mari exports 
all patches).

2. Do one of the following:

If other objects in your project have the same channel name, Mari 
prompts you to choose whether you want to export the channel for the 
current object only or all objects.

Next, the Export Channel dialog box displays.

Select from menubar or click on toolbar
or right-click in Channels 
palette and select

Channels > Export Export
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Exporting 
3. On the Sequence tab, enter the Path where you want to store the 
export, or use the browse panes (the two left-hand navigation panes) to 
browse to it.

4. For the Template, either use the default filename template or edit it as 
required.

5. If you are exporting an animated sequence and want to export only the 
textures for a particular frame range, enter the range in the Frame 
Range field on the Mesh Options tab.

6. Click either All (to export all patches on the model) or Modified Only (to 
export only the patches that have been modified since the project was 
last exported).

If Small Textures is enabled, Mari exports any patches that you haven't 
painted yet as 8x8-pixel textures. When you start to paint on a particu-
lar patch, Mari exports it as the correct size.

Tip • Make sure you check the path and name carefully, especially ifyou have 
been swapping between assets — Mari defaults to the last place you've 
exported. Don't risk overwriting your textures!

• The steps above assume you are exporting a sequence of patches with 
the udim number (1001, 1002, etc.) in the file names. If you'd rather 
assign individual files to each patch, you can do so on the Named Files 
tab of the Export Channel dialog. Click the buttons on the right to open a 
file browser and pick a file for each patch. Then, click All or Modified 
Only to export the files. Note that by default the Named Files tab doesn't 
appear if you have more than 20 patches in your object. To change this 
number, you can use the Patch Cutoff preference or set the 
MARI_NAMEDFILEIMPORT_SEQUENCELIMIT environment variable to a 
new value.
Mari 1.4v2The Foundry
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Importing 
Importing To import a channel you have exported:

1. If you want to manually select which patches to import, select the 
patches to import onto.

2. Do one of the following:

If other objects in your project have the same channel name, Mari 
prompts you to choose whether you want to import the channel onto 
the current object only or all objects.

Next, the Import Channel dialog box displays:

3. Enter the Path for the files to import, or use the browse panes (the two 
left-hand navigation panes) to browse to them.

Tip The steps above assume you are importing a sequence of patches with the 
udim number (1001, 1002, etc.) in the file names. If you'd rather assign 
individual files to each patch, you can do so on the Named Files tab of the 
Import Channel dialog. Click the buttons on the right to open a file browser 
and pick a file for each patch. Then, click All to import the files. Note that by 

Select from menubar or right-click in Channels palette and select

Channels > Import Import
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Importing 
default the Named Files tab doesn't appear if you have more than 20 
patches in your object. To change this number, you can use the Patch Cutoff 
preference or set the MARI_NAMEDFILEIMPORT_SEQUENCELIMIT 
environment variable to a new value.
Mari 1.4v2The Foundry
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